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PHOTOSHOP CS5 CŀN BʝN, ÚT B N˃H SOʛN:  

 
PHOTOSHOP CS5 CŀN BʝN Tθ 1 ņ́N 10 (9,31 MB):  
http://goo.gl/JmO7b  

http://www.mediafire.com/?r03xd40yb4ayjwv  
PHOTOSHOP CS5 CŀN BʝN Tθ 11 ņ́N 20 (10,07 MB):  
http://goo.gl/Q3Ee4  
http://www.mediafire.com/?vn81umaoufa0mt6  
PHOTOSHOP CS5 CŀN BʝN Tθ 21 ņ́N 30 (8,29 MB):  
http://goo.gl/ugKyH  

http://www.mediafire.com/?un927fa7xp2hbv4  
PHOTOSHOP CS5 CŀN BʝN Tθ 1 ņ́N 30 (30,85MB):  
http://goo.gl/1HGy1  
 http://www.mediafire.com/?5c82s0070dagt2n  
PHOTOSHOP CS5 CŀN BʝN Tθ 1 ņ́N 30 (30,85MB):  
http://goo.gl/1HGy1  

http://www.medi afire.com/?5c82s0070dagt2n  

 
 
21 . ʝNH IN TRąN GIʟY Vê ʝNH TRąN MêN HČNH. 
 
ʝnh hi˂n tr°n giʠy v̈ ʞnh tr°n m̈ n h³nh rʠt kh§c nhau. H«y ghi nhΩ diue962 n̈y khi tʜo v̈ xuʠt bʞn 

ʞnh tr°n cʞ 2 phʇʅng ti°ʉn. Sau Ľ©y laʊ nhʇωng khaʋc bi°ʉt: 
 

¶ VŁn baʈn duʊ nhoʈ nhʇng v©ωn d°ω Ľoʉc tr°n gi©ʋy , v³ c§c Ľiʾm mοc in tr°n giʠy sʪc n®t hʅn c§c 
Ľi°ʈm saʋng tr°n maʊn hēʊnh. Ch²nh v³ vʨy bʜn sy kh¹ng nh³n thʠy c§c vŁn bʞn nhΜ ho̡c c§c h³nh 
Ľ¹ʊ hoʉa quaʋ chi ti°ʋt tr°n maʊn hēʊnh. 
 

¶ M n̈ h³nh m§y t²nh c· nhi̓u k²ch cέ kh§c nhau v̈ cƶng kh¹ng chʪc chʪn rʬng ngʇΫi xem sy 
sʇʈ duʉng cuʊng m¹ʉt kēʋch cʅʈ maʊn hēʊnh .v³ vʨy c§c tr³nh b̈y cεa bʜn n°n ph½ hαp vΩi loʜi m̈ n 
h³nh nhΜ th¹ng thʇΫng : Loʜi 15 inches. Khi thi°ʋt k°ʋ Ľ°ʈ  in tr°n gi©ʋy , bʜn cʢn bi̋t k²ch cέ 
gi©ʋyĽ°ʈ trēʊnh baʊy phuʊ hʅʉp, tuy nhi°n Trang trong Ľiʉnh daʉng HTML hoŁʉc PDF c· thʾ c· chi̓u 
d̈i bʠt kǐ. 

 
¶ M̈ n h³nh m§y t²nh thʇΫng nʬm nagng , trong khi Trang In truy°ʊn th¹ʋng thʇʅʊng theo chi°ʊu 
Ľʇʋng. ņi°ʊu cʅ baʈn naʊy seω aʈnh hʇʅʈng tʅʋi sʇʉ trēʊnh baʊy vaʊ Ľiʉnh daʉng Trang cuʈa baʉn. 

 
¶ C§c ʠn bʞn thʇΫng Ľʇαc ĽΚc li°n t¼c , ngʇʅʊi Ľoʉc phaʈi l©ʉt tʇʊ trang naʊy tʅʋi trang kia.Trong xu©ʋt 
bʞn trοc tuy̋n (Online Publication), ngʇʅʊi xem coʋ th°ʈ di chuy°ʈn tʅʋi Trang  hoŁʉc viʉ trēʋ b©ʋt kyʊ, 

http://goo.gl/JmO7b
http://www.mediafire.com/?r03xd40yb4ayjwv
http://goo.gl/Q3Ee4
http://www.mediafire.com/?vn81umaoufa0mt6
http://goo.gl/ugKyH
http://www.mediafire.com/?un927fa7xp2hbv4
http://goo.gl/1HGy1
http://www.mediafire.com/?5c82s0070dagt2n
http://goo.gl/1HGy1
http://www.mediafire.com/?5c82s0070dagt2n


2 

 

v̈o bʠt cη l¼c n̈o bʬng c§ch ch˄ Ľ̂nh Trang muΞn di chuyʾn tΩi , hoŁʉc nh©ʋp vaʊo m¹ʉt Ľi°ʈm 
li°n k°ʋt (Link) Ľʾ di chuyʾn tΩi Trang, v̂ tr² ho̡c mΧt xuʠt bʞn phʤm kh§c. 
 

1.  ņΦ PHĄN GIʝI Vê KĉCH Cά ʝNH. 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 

 

  Ch¼ng ta quan s§t H³nh Minh HΚa έ tr°n v̈ c· nhνng nhʨn x®t sau Ľ©y: 
 

¶ Khi baʉn phoʋng r¹ʉng m¹ʉt aʈnh nh©ʋt laʊ Ľiʉnh daʉng Bitmap  bʜn sy thʠy tιng Pixel 
k°ʋt nΞi vΩi nhau Ľʾ tʜo ra ʞnh. 

¶ C½ng mΧt k²ch cέ ʞnh nhʇng ch̄n nhi̓u Pixel v̈o cʞ 2 chi°ʊu k²ch cέ th³ 
ʞnh c̈ng r»:   M¹ʉt aʈnh kēʋch cʅʈ r¹ʉng, ngang laʊ 1 inch baʉn baʉn cheʊn 72 pixel vaʊo 

chi°ʊu r¹ʉng r¹ʉng vaʊ chi°ʊu cao ngang thēʊ baʉn  th©ʋy aʈnh naʊy kh¹ng roω bŁʊng khi baʉn 
ch̄n 300 pixels vaʊo. ņΧ r» chi ti̋t tŁng gʢn gʠp 3. T·m lʜi trong 1 Inch n°ʋu baʉn 
ch̄n nhi̓u Pixels v̈o th³ c̈ng r», Ľeʉp nhʇng kh¹ng n°n quaʋ 300 pixels. Dƙ nhi°n 

dung lʇʅʉng c̈ng nhi̓u Pixel th³ c̈ng cao. 
¶ ņΧ Ph©n Gʞi Ľʇαc t²nh bʬng sΞ Pixel/Inch:  ά Ľ©y bʜn c· ʞnh c· ĽΧ ph©n giʞi 

(Resolution) l̈ 72 v̈ ʞnh c· ĽΧ ph©n giʞi l̈ 300.  
¶ ņ°ʈ chēʈnh sʇʈa aʈnh trong Photoshop, ʞnh phʞi c· ĽΧ ph©n giʞi th²ch hαp. 

¶ Thu©ʉt ngʇω ņΧ Ph©n Giaʈi (Resolution) n·i tΩi sΞ lʇαng c§c h³nh vu¹ng nhΜ Ľʇαc 

gΚi l̈ c§c PIXEL  (Picture Element ï Ph©ʊn tʇʈ aʈnh) d½ng Ľʾ m¹ tʞ v̈ t§i tʜo chi ti̋t 
cho aʈnh. ņΧ ph©n giʞi sy x§c Ľ̂nh k²ch cέ cεa Pixel ho̡c sΞ pixel theo chi̓u daʊi, 
chi°ʊu r¹ʉng cuʈa aʈnh. 

¶ Tham Khaʈo th°m v°ʊ ņ¹ʉ Ph©n Giaʈi, b̈i vi̋t cεa Đt B˄nh ng̈y 14.2.2009 tʜi: 
http://utbinh.com/A2/150209/KICHTHUOC.doc 
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2.  CĆC LOʛI ņΦ PHĄN GIʝI 
 
¶ ņΦ PHĄN GIʝI ʝNH (Image Resolution): S¹ʋ Pixel tr°n m¹ʉt Ľʅn viʉ chi°ʊu daʊi cuʈa 

ʞnh Ľʇαc gΚi l̈ ņΧ Ph©n Giʞi ʝnh thʇΫng Ľʇαc Ľo bʬng sΞ Pixel tr°n mΧt Inch (ppi). 
ʝnh c· ĽΧ ph©n giʞ cao sy c· nhi̓u Pixel hʅn v̈ dung lʇαng cƶng sy lΩn hʅn ʞnh c· 

c½ng k²ch thʇΩc nhʇng c· ĽΧ ph©n giʞi thʠp. Trong Photoshop baʉn coʋ th°ʈ thay Ľ¹ʈi Ľ¹ʉ 
ph©n giaʈi tʇʊ cao (300 ppi hoŁʉc hʅn) xu¹ʋng Ľ¹ʉ ph©n giaʈi th©ʋp (72 ppi hoŁʉc 96 ppi).  
 

¶ ņΦ PHĄN GIʝI CδA MêN HČNH (Monitor Resolution ): S¹ʋ Pixel tr°n m¹ʉt Ľʅn viʉ 
chi°ʊu daʊi maʊn hēʊnh Ľʇʅʉc goʉi laʊ  ņΧ Ph©n Giʞi cεa m̈ n H³nh (Monitor Resolution) 

thʇʅʊng Ľu¹c Ľo bŁʊng s¹ʋ ņi°ʈm (dot)  trên Inch . C§c Pixel cεa ʞnh Ľʇαc chuyʾn trοc 
ti°ʋp thaʊnh caʋc pixel cuʈa maʊn hēʊnh. 

 
o Trong Photoshop n°ʋu Ľ¹ʉ ph©n giaʈi cuʈa aʈnh cao hʅn Ľ¹ʉ ph©n giaʈi cεa m̈ n h³nh 
ʞnh sy thʾ hi˂n tr°n maʊn hēʊnh lʅʋn hʅn kēʋch thʇʅʋc khi chuʋng Ľʇʅʉc in ra. V² dγ: 

Khi baʉn th°ʈ hi°ʉn file aʈnh 1X1 inch, 144 ppi  tr°n maʊn hēʊnh 72 ppi , ʞnh sy 
chi°ʋm m¹ʉt vuʊng 2X2 inches tr°n maʊn hēʊnh. 

o Vʅʋi Ľ¹ʉ thu phoʋng aʈnh (Zoom) tr°n maʊn hēʊnh laʊ 100% th³ 1 pixel aʈnh seω bŁʊng 1 

pixel maʊn hēʊnh. N°ʋu Ľ¹ʉ ph©n giaʈi cuʈa aʈnh kh¹ng bŁʊng Ľuʋng vʅʋi Ľ¹ʉ ph©n giaʈi 
cεa m̈ n h³nh , k²ch thʇΩc ʞnh (Theo inch hoŁʉc cm) trên m̈ n h³nh sy lΩn hʅn 

hoŁʉc nhoʈ hʅn kēʋch thʇʅʋc th©ʉt khi in ra. 
 
 

 
 

 
 
 

 
 
 

  
 

 
 
 

 
 

 
 
 
                       ʝnh 2X3 inches , Ľ¹ʉ ph©n giaʈi 72 ppi,         ʝnh 2X3 inches , Ľ¹ʉ ph©n giaʈi 200  ppi  
                             Dung lʇʅʉng 91 KB, thu phoʋng 100%          Dung lʇʅʉng 703  KB, thu ph ·ng 100 %  
 

 
 

¶ ņΦ PHĄN GIʝI CδA MĆY IN (Printer Resolution): S¹ʋ lʇʅʉng caʋc haʉt mʇʉc taʉo ra 

tʇʊ maʋy in phim hoŁʉc maʋy in Laser goʉi laʊ ņ¹ʉ Ph©n Giaʈi Maʋy In (Printer Resolution). ņΧ 
Ph©n giaʈi cuʈa Maʋy In vaʊ ņ¹ʉ ph©n giaʈi cuʈa aʈnh caʊng cao t h³ chʠt lʇαng bʞn in c̈ng 

tŁng. ņΧ ph©n giʞi th²ch hαp khi in ʞnh Ľʇαc Ľ̂nh bέi ĽΧ ph©n giʞi cεa m§y in v̈ bέi 
T©ʊn s¹ʋ Lʇʅʋi ( Screen Frequency hay Screen Rulling). Hafttone Frequency laʊ Ľʅn viʉ Ľo 

s¹ʋ doʊng giaʈ l©ʉp tr°n caʋc sŁʋc th§i, Ľ¹ʉ Ľ©ʉm nhaʉt (Shade)  cεa m̈ u bʬng c§ch chuyʾn 
ʞnh (Continuous Tone laʊ aʈnh coʋ t¹ng maʊu li°n tuʉc, chuy°ʈn miʉn maʊng tʇʊ maʊu naʊy sang 
m̈ u kh§c, v² dγ nhʇ trong c§c ʞnh chγp ) sang m¹ʉt aʈnh Ľʇʅʉc c©ʋu thaʊnh bʅʈi nhʇωng 
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Ľi°ʈm nhoʈ li ti vʅʋi caʋc kēʋch cʅʈ khaʋc nhau , d½ng cho vi˂c in Offset. ņΧ ph©n giʞi ʞnh 
c̈ng cao , dung lʇʅʉng file caʊng lʅʋn, download tʇʊ Web v°ʊ caʊng l©u. 

 
 
 
 

 
  
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 

 
 
 

22 . LêM THʭNG VAʊ XEʋN AʈNH, CĎNG CUʉ CROP. 
 
DOWNLOAD AʈNH THξC TʧP TʛI (31,38 MB):  http://goo.gl/d0V4B  

 
Trong baʊi t©ʉp naʊy bʜn sy ch˄nh sλa v̈ chuʤn b̂ ʞnh vΩi k²ch thʇΩc 2 X 3 inches  phuʉc vuʉ cho vi°ʉc 
d̈n trang cεa mΧt tʜp ch². Khʅʈi Ľ¹ʉng Photoshop vʅʋi caʋc xaʋc l©ʉp mŁʉc Ľiʉnh. 

 
1. Menu File | Open | ņ°ʋn file 03End.psd trong Folder Lessons|Lesson03. 
2. Khi xem xong baʉn coʋ th°ʈ ĽŁʉt noʋ b°n caʉnh Ľ°ʈ tham khaʈo hoŁʉc Ľoʋng laʉi kh¹ng c©ʊn lʇu. 

3. Bʜn mέ file 03Start.psd trong Folder Lessons|Lesson03. File naʊy tr¹ng xēʈn, mʅʊ Ľuʉc, ʞnh qu®t 
b̂ nghi°ng v̈ k²ch thʇΩc chʇa ph½ hαp vΩi y°u cʢu . Bʜn sy hön thi˂n lʜi n· bʬng c§c kχ 
thu©ʉt chēʈnh sʇʈa trong Photoshop CS5. 

 

DĒNG CĎNG Cβ DROP ņ̔  X£N Vê QUAY ʝNH  
 
1. ChΚn C¹ng cγ Drop, trên thanh  t½y chΚn nhʨp Width 2 inches vaʊ Height 3 inches > R° taʉo 

khung xeʋn l°n aʈnh theo Hēʊnh Minh Hoʉa.  
 
¶ Trong khi r° baʉn th©ʋy: Khung xeʋn lu¹n giʇω t˄ l˂ 2/3  (ņaω Ľʇʅʉc nh©ʉp trʇʅʋc Ľ©y trong 

h¹ʉp nh©ʉp Width vaʊ Height) ï Khi thaʈ chu¹ʉt baʉn th©ʋy m¹ʉt m n̈ che (Cropping Shield) 
bao phuʈ b°n ngoaʊi khung xeʋn ï Tr°n thanh tuʊy choʉn cuωng th°ʈ hi°ʉn caʋc tuʊy choʉn cho 

m̈ n che: C· dʠu chΚn trong Shield , Opacity  75% - T½y chΚn Perspective   không 
Ľʇʅʉc choʉn. 

 

http://goo.gl/d0V4B
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2. Di chuy°ʈn con troʈ ra b°n ngoaʊi goʋc phaʈi tr°n, con troʈ bi°ʋn thaʊnh muʈi t°n cong 2 Ľ©ʊu , rê 
theo chi°ʊu kim Ľ¹ʊng h¹ʊ cho Ľ°ʋn khi caʉnh cuʈa khung xeʋn song song vʅʋi caʉnh bi°n tr°n cuʈa 
ph©ʊn aʈnh c©ʊn xeʋn. 
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3. ņ̡t con trΜ v̈o trong Khung xeʋn, r° di chuy°ʈn khung xeʋn cho tʅʋi khi m¹ʉt goʋc cuʈa khung xeʋn 
khʅʋp vʅʋi goʋc cuʈa ph©ʊn aʈnh mu¹ʋn xeʋn ( Ch¼ Ĩ kh¹ng Ľʾ vʇαt qu§). Bʜn c· thʾ nhʠp Ph²m mεi 

t°n Ľ°ʈ di chuy°ʈn khung xeʋn tʇʊng bʇʅʋc. 
 

 

 
  
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

4. Nh©ʋp Phēʋm Enter Ľ°ʈ hoaʊn t©ʋt quaʋ trēʊnh xeʋn. ʝnh Ľ« Ľʇαc quy thʮng v̈ x®n Ľ¼ng k²ch thʇΩc 2 
X 3 inches. ChΚn Menu File | Save Ľ°ʈ lʇu file naʊy. 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

ʟN ņ˅NH ņΦ PHĄN GIʝI CHO ʝNH 
 

1. Nh©ʉp Giaʋ Triʉ vaʊ ņʅn viʉ tēʋnh:  G¹ʊm coʋ H¹ʉp nh©ʉp Width vaʊ Height duʊng Ľ°ʈ xaʋc Ľiʉnh tyʈ l°ʉ eʋp 

bu¹ʉc cho khung xeʋn, k²ch thʇΩc tḧnh phʤm sau khi x®n. Khi nh©ʉp giaʋ triʉ vaʊo 2 h¹ʉp naʊy n°ʋu 
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bʜn kh¹ng nhʨp Ľʅn v̂ t²nh k̄m theo th³ m̡ c Ľ̂nh cεa n· l̈ inche . C· th°ʈ thay Ľ¹ʈi Ľʅn viʉ 
t²nh , v̈o Menu Edit | References | Units & Rulers  v̈ chΚn mΧt Ľʅn v̂ kh§c ho̡c nhʠp 

Phʞi v̈o Ď nhʨp n̈y v̈ chΚn mΧt Ľʅn v̂ tι Context Manu. 
 

2. ņΧ ph©n giʞi:   

¶ Mʅʈ m¹ʉt File ʞnh > ChΚn c¹ng cγ Crop > Nh©ʋp Nuʋt Front Image >  Hi°ʉn ra kēʋch cʅʈ vaʊ 
Resolution cuʈa aʈnh naʊy. 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 

 
 

 
 

 

¶ Mʅʈ File aʈnh ti°ʋp theo, crop aʈnh mʅʋi seω coʋ kcēʋh cʅʈ vaʊ Ľ¹ʉ ph©n giaʈi gi¹ʋng aʈnh trʇʅʋc. 
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¶ Tʇʉ ĽŁʉt ņ¹ʉ Ph©n giaʈi cho aʈnh:  Sau khi xeʋn Ľ¹ʉ ph©n giaʈi tuʊy thu¹ʉc vaʊo kēʋch cʅʈ eʋp 
bu¹ʉc vaʊ Ľ¹ʉ ph©n giaʈi cuʈa aʈnh goʋc . Bʜn cƶng c· thʾ §p Ľ̡t ĽΧ ph©n giʞi bʬng hΧp 

nh©ʉp Resolution sau Ľoʋ bŁʋt Ľ©ʊu crop . Nh©ʋp Nuʋt Clear Ľ°ʈ xoʋa caʋc giaʋ triʉ hi°ʉn haʊnh 
trong h¹ʉp Width ï Height vaʊ Resolution. 

 
 

 

 
 
 

  
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
                                          

 
                                             ʝnh g·c c· ĽΧ ph©n giʞi 72 ï Width 500 ï Height 753 -  107 KB  

 
 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
                                     Nh©ʉp ņ¹ʉ ph©n giaʈi 300 v̈ Crop c· Width 2083 ï Height 3137 - 617 K  
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CĆC THAO TĆC VΨI KHUNG X£N 
 

1. Di Chuy°ʈn Khung Xeʋn:  Sau khi r° taʉo Khung Xeʋn, bʜn c· thʾ Ľi̓u ch˄nh trοc ti̋p n· bʬng 
c§c thao t§c sau: ņʇa con troʈ vaʊo phēʋa trong Khung Xeʋn vaʊ r° hoŁʉc nh©ʋn caʋc phēʋm Muʈi T°n 
HoŁʉc Shift + Ph²m Mεi T°n. 

2. ņi°ʊu chēʈnh kēʋch thʇʅʋc Khung Xeʋn:  C· thʾ r° c§c Handle (C§c n¼t nhΜ cεa Khung x®n)  έ 
g·c bʬng c§ch Shift+R° caʋc caʉnh cuʈa Khung Xeʋn. N°ʋu chʇa nh©ʉp gi§ tr̂ ®p buΧc trong Khung 

Nh©ʉp thēʊ baʉn coʋ th°ʈ r° nʅʋi r¹ʉng hay thu heʉp caʋc caʉnh cuʈa Khung Xeʋn. 
 

 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

3.  Thanh Tuʊy choʉn sau khi Khung Xeʋn Ľʇʅʉc taʉo:  
 
¶ T½y ChΚn Shied  Ľʇʅʉc choʉn laʊm xu©ʋt hi°ʉn maʊn che b°n ngoaʊi Khung Xeʋn (Ph©ʊn loaʉi 

bΜ). M̈ n che n̈y c· m̈ u cεa Ď Color (M̈ u t²m) v̈ ĽΧ mΫ Ľοc dʇαc x§c Ľ̂nh trong Ď 
Opacity(75%) trong baʊi naʊy. 

¶ T½y chΚn Cropped Area  kh¹ng coʋ hi°ʉu lʇʉc vʅʋi Layer Background (B̈i Ľang Crop tr°n 

Layer Background), ch˄ c· hi˂u lοc vΩi Layer th¹ng thʇΫng. 
¶ N°ʋu choʉn tuʊy choʉn Delete , sau khi xeʋn ph©ʊn aʈnh b°n ngoaʊi seω biʉ xoʋa. 
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¶ N°ʋu choʉn tuʊy choʉn Hide , sau khi xeʋn ph©ʊn aʈnh b°n ngaoēʊ seω kh¹ng biʉ xoʋa , n· ch˄ b̂ 
ʤn Ľi.Bʜn c· thʾ d½ng c¹ng cuʉ Move vaʊ r° r° trong aʈnh Ľ°ʈ th©ʋy laʉi ph©ʊn biʉ ©ʈn. 

¶ N°ʋu tuʊy choʉn Perpective Ľʇʅʉc choʉn, bʜn c· thʾ r° k®o Handle mΧt c§ch ĽΧc lʨp 
(Kh¹ng phoʋng to ra theo tyʈ l°ʉ quy Ľiʉnh cuʈa H¹ʉp nh©ʉp Width-Height), kh¹ng khi r° baʉn 

giʇω ph²m Shift Ľʾ ®p buΧc giν theo hʇΩng ngang ho̡c Ľηng . Sau khi hoaʊn t©ʋt vi°ʉc 
x®n,ʞnh tḧnh phʤm sy l̈ k̋t quʞ cεa vi˂c ®p c§c cʜnh cεa khung x®n v̓ lʜi h³nh chν 

nh©ʉt. Khi tuʊy choʉn naʊy Ľʇʅʉc choʉn thēʊ Cropped Area  kh¹ng coʋ hi°ʉu lʇʉc. 
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¶ Sau khi taʉo khung xeʋn, bʜn c· thʾ crop bʬng c§ch : Nh©ʋp Ľuʋp l°n Khung 
x®n ho̡c nh©ʋp Phaʈi l°n Khung xeʋn, chΚn Crop tʇʊ Context Menu hoŁʉc nh©ʋp Nuʋt 

Commit Current Crop Operation . 
¶ N°ʋu mu¹ʋn huʈy Khung xeʋn :  Bʜn nhʠp Ph²m Escape  hoŁʉc nh©ʋp nuʋt Cancel 

Current Crop Operation  tr°n thanh tuʊy choʉn hoŁʉc nh©ʋp Phaʈi vaʊo aʈnh choʉn 
Cancel.  

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
4. ņiʉnh laʉi kēʋch cʅʈ cho Khung Xeʋn : Th¹ng thʇʅʊng khi Ľiʉnh laʉi kēʋch cʅʈ cho khung xeʋn n°ʋu 

Menu View | Sanp To | Document Bounds Ľʇʅʉc choʉn, khi r° nuʋt Handle Ľ°ʈ Ľi°ʊu chēʈnh 
bi°n cuʈa khung xeʋn seω biʉ h¼t v̈o bi°n ʞnh. ņ°ʈ loaʉi boʈ tēʋnh nŁng naʊy baʉn boʈ choʉn noʋ hoŁʉc 
giʇω Ctrl trong khi r°keʋo caʋc Handle cεa Khung x®n. 

 
Trong aʈnh naʊy baʉn r° Ľ°ʈ taʉo Vuʊng Bi°n cho aʈnh: 
 

¶ Mʅʈ r¹ʉng cʇʈa s¹ʈ aʈnh lʅʋn hʅn aʈnh > ChΚn c¹ng cγ Drop v̈ r° tʜo mΧt khung x®n > Giʇω 
Alt vaʊ r° Handle Ľ°ʈ mʅʈ r¹ʉng khung xeʋn ra ngaoēʊ bi°n aʈnh > NH©ʋp Enter Ľ°ʈ hoaʊn t©ʋt. 
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                                        Ph©ʊn mʅʈ r¹ʉng aʈnh coʋ maʊu Background hi°ʉn haʊnh. 
 
 

23. LąʉNH LEVELS 
 
Phʜm vi t¹ng m̈ u cεa ʞnh m¹ tʞ sο tʇʅng phʞn v̈ ĽΧ chi ti̋t cεa ʞnh , n· Ľʇαc x§c Ľ̂nh bʅʈi sʇʉ 
ph©n b¹ʈ caʋc pixel, tʇʊ caʋc pixel t¹ʋi nh©ʋt (m̈ u Ľen) tʅʋi caʋc pixel saʋng nh©ʋt (m̈ u trʪng). Bʜn sy ch˄nh 

sʇʈa Ľ¹ʉ tʇʅng phaʈn cuʈa aʈnh bŁʊng l°ʉnh Levels. 
 

1. Ch˄nh ʞnh thʮng ḧng:  Mʅʈ file aʈnh 03Start.psd (Lessons03) > Bʜn thʠy ʞnh b̂ nghi°ng, 

nh©ʋp Phēʋm F7 Ľʾ mέ Tab Layers > Nh©ʋp Phēʋm Ctrl+J Ľ°ʈ mʅʈ Layer 1 > Nh©ʋp Ctl+T Ľ°ʈ mʅʈ 
Khung coʋ Handle, mʅʈ lʇʅʋi: View > Show > Grid r° xoay di chuy°ʈn chēʈnh aʈnh cho thŁʈng haʊng 

> Nh©ʋp Phēʋm Enter. 
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2. Mʅʈ HT Levels:  ChΚn Menu Image | Adjustment | Levels hoŁʉc Ctrl+L Ľ°ʈ mʅʈ h¹ʉp thoaʉi Levels. 
Trong h¹ʉp thoaʉi tuʊy choʉn Preview phaʈi Ľʇʅʉc choʉn Ľ°ʈ coʋ th°ʈ th©ʋy Ľʇʅʉc caʋc bi°ʋn Ľ¹ʈi trong cuʈa 

s¹ʈ aʈnh, trong khi thay Ľ¹ʈi caʋc tuʊy choʉn. N°ʋu c©ʊn bʜn di chuyʾn HT Levels sang b°n cʜnh Ľʾ 
th©ʋy cʇʈa s¹ʈ aʈnh vaʊ h¹ʉp thoaʉi cuʊng luʋc. 
 

GIʝI THĉCH: 
 
¶ Tam giaʋc maʊu Ľen b°n Traʋi: ņaʉi di°ʉn cho maʊu t¹ʋi (Shadow). 

¶ Tam giaʋc maʊu trŁʋng b°n Phaʈi: ņaʉi di°ʉn cho maʊu saʋng (Highlight).  

¶ Tam giaʋc m̈ u x§m έ giνa: ņaʉi di°ʉn cho maʊu trung tēʋnh (Midtone hoŁʉc gamma). 
 

Ti°u chu©ʈn m¹ʉt aʈnh Ľeʉp:   
 

¶ ʝnh Ľeʉp:  C· ĽΧ tʇʅng phaʈn t¹ʋt th³ c§c cΧt cεa biʾu ĽΠ sy trʞi suΞt theo t¹ng maʊu, tʇʊ 
tam giaʋc maʊu Ľen tʅʋi tam giaʋc maʊu trŁʋng.  

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 

 

¶ ʝnh x©ʋu:  Ngʇʅʉc laʉi caʋc c¹ʉt cuʈa bi°ʈu Ľ¹ʊ chēʈ t©ʉp trung ʅʈ giʇωa bi°ʈu Ľ¹ʊ , ʞnh sy kh¹ng c· 
m̈ u thʨt sο tΞi v̈ thʨt sο s§ng, ʞnh sy c· Ľ¹ʉ tʇʅng phaʈn keʋm. 

 
 

 
 
 

  
 

 
 
 

 
 
 

 
 

 
 
 

 
3. Tam giaʋc maʊu Ľen:  Bʜn c· thʾ Ľi̓u ch˄nh c§c tam gi§c Ľen v̈ tam gi§c trʪng Ľʾ mέ rΧng 

phʜm vi t¹ng m̈ u cho ʞnh. R° tam giaʋc Ľen b°n traʋi v°ʊ b°n phaʈi Ľ°ʋn viʉ trēʋ bŁʋt Ľ©ʊu c· c§c 
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m ü tΞi nh©ʋt tr°n bi°ʈu Ľ¹ʊ. Trong khi r° nhʅʋ quan saʋt sʇʉ bi°ʋn Ľ¹ʈi cuʈa aʈnh . Gi§ tr̂ trong ¹ 
nh©ʉp Ľ©ʊu ti°n seω thay Ľ¹ʈi theo vaʊ ph©ʊn maʊu t¹ʋi tr°n cʇʈa s¹ʈ file aʈnh seω trʅʈ n°n t¹ʋi hʅn. 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 

4. Tam giaʋc maʊu trŁʋng:   R° qua traʋi Ľ°ʋn v̂ tr² bʪt Ľʢu c· c§c m ü nhʠt nhʠt. Gi§ tr̂ trong 

¹ nh©ʉp cu¹ʋi sy thay ĽΣi v̈ ʞnh trέ n°n s§ng hʅn. 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
5. Tam giaʋc maʊu xaʋm:  R° qua traʋi m¹ʉt chuʋt . Gi§ tr̂ trong ¹ nhʨp έ giνa sy thay ĽΠi v̈ c§c gi§ 
tr̂ c· ĽΧ s§ng trung b³nh trong ʞnh sy s§ng hʅn mΧt ch¼t . B©y giʅʊ tr¹ng aʈnh Ľaω saʋng suʈa 

hʅn, ʞnh Ľ« c· c§c gi§ tr̂ Levels l̈: 18 - 1.30 ï 232 > Nh©ʋp Ok. 
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6. Histogram:  V̈o Menu Window | Histogram  hi°ʉn ra HT Histogram Ľ°ʈ baʉn xem laʉi bi°ʈu Ľ¹ʊ 

t¹ng maʊu Ľaω Ľʇʅʉc traʈi r¹ʉng tʇʊ Ľ©ʊu tʅʋi cu¹ʋi thang c©ʋp Ľ¹ʉ saʋng (levels) kh¹ng coʊn co cuʉm nhʇ 
ban Ľ©ʊu. Nh©ʋp nuʋt Close. 

 

 
 

 
 
 

 
 

 
 
 

 
 

¶ TĎNG MAʊU, PHʛM VI TĎNG MêU Vê BI̔U ņΟ TH̔  HIˁN. 
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24.  LąʉNH AUTO CONTRAST Vê EQUALIZE 
 
L NˁH AUTO CONTRAST 
 

1. Bʜn c· thʾ Ľi̓u ch˄nh tο ĽΧng ņΧ Tʇʅng Phʞn (ņi°ʊu chēʈnh caʋc giaʋ triʉ saʋng highlight vaʊ caʋc 
gi§ tr̂ tΞi shadow) v̈ ĽΧ Ph¹ʋi Tr¹ʉn Maʊu t¹ʈng quaʋt bŁʊng L°ʉnh Menu Image | Auto Contrast 

(Alt+ Shift+ Ctrl+ L). L°ʉnh naʊy sy §nh xʜ c§c pixel tΞi nhʠt v̈ s§ng nhʠt cεa ʞnh tḧnh m̈ u 
Ľen vaʊ maʊu trŁʋng. Ch¼ng ta thλ so s§nh ʞnh Begin v̈ After sau khi §p dγng L˂nh Auto 
Contrast. 

 
¶ Mʅʈ m¹ʉt file aʈnh > Menu Image > Duplicate Ľ°ʈ nh©n Ľ¹i aʈnh > ChΚn mΧt ʞnh > Nh©ʋp 

Menu Image > Auto Contrast seω th©ʋy aʈnh ph©ʊn t¹ʋi seω t¹ʋi hʅn vaʊ ph©ʊn saʋng seω saʋng 
hʅn. 
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2. Vi°ʉc aʋnh xaʉ naʊy seω laʊm cho ph©ʊn saʋng seω saʋng hʅn vaʊ ph©ʊn t¹ʋi seω t¹ʋi hʅn, gi¼p cʞi thi˂n chʠt 
lʇʅʉng cho caʋc aʈnh chuʉp hoŁʉc caʋc aʈnh continuous tone  . L°ʉnh Auto Contrast seω kh¹ng coʋ 

hi°ʉu quaʈ vʅʋi caʋc aʈnh coʋ nhi°ʊu mʞng m ü ĽΠng nhʠt, kh¹ng chuy°ʈn maʊu (Çn gΚi l̈ c§c 
ʞnh Flat Color Images). 

 

 
 
 

  
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
3. L°ʉnh Auto Contrast seω l©ʋy 0,5 % t¹ʈng s¹ʋ pixel cεa ʞnh έ phʢn tΞi nhʠt chuyʾn tḧnh m̈ u 
Ľen  vaʊ 0,5% t¹ʈng s¹ʋ pixel cuʈa aʈnh ʅʈ ph©ʊn saʋng nh©ʋt chuy°ʈn thaʊnh maʊu trŁʋng . ņi°ʊu naʊy seω 

bʞo Ľʞm cho m̈ u Ľen v̈ m̈ u trʪng Ľʇαc thʾ hi˂n r» , thay vēʊ chēʈ coʋ m¹ʉt v̈i pixel Ľʇαc qui 
Ľ¹ʈi. 

 

25. LąʉNH EQUALIZE  
 

1. L°ʉnh Equalize thʇʅʊng Ľʇʅʉc duʊng Ľ°ʈ chēʈnh sʇʈa nhʇωng aʈnh coʋ Ľ¹ʉ tʇʅng phaʈn keʋm v̈ 
qu§ tΞi. Tʇʅng tʇʉ nhʇ L°ʉnh Auto Contrast, l°ʉnh Equalize (Menu Image | Adjustments | 

Equalaize) cƶng §nh xʜ c§c pixel tΞi nhʠt v̈ s§ng nhʠt cεa ʞnh tḧnh m̈ u Ľen v̈ m̈ u 
trŁʋng. Nhʇng sau Ľoʋ seω c¹ʋ gŁʋng l̈m Ľ̓u ĽΧ s§ng cho aʈnh bŁʊng caʋch daʊn Ľ°ʊu caʋc giaʋ triʉ 

pixel trung gian tr°n su¹ʋt thang c©ʋp Ľ¹ʉ saʋng (level).  
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2. Bʜn d½ng L˂nh Window | Histogram Ľ°ʈ so saʋnh k°ʋt quaʈ cuʈa 2 l°ʉnh: Auto Contrast vaʊ 
Equalize. 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

  
              

 
 
 

          Bi°ʈu Ľ¹ʊ phaʉm vi t¹ng maʊu cuʈa aʈnh g¹ʋc 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

  
 

 

 
 
 

 
Sau khi duʊng L°ʉnh Auto Contrast 
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                                                        Sau khi duʊng L°ʉnh Equalize 

 
3.  Khi m¹ʉt aʈnh Ľang coʋ vuʊng choʉn maʊ baʉn aʋp duʉng L°ʉnh Equalize seω laʊm xu©ʋt hi°ʉn m¹ʉt H¹ʉp 
Thoʜi Equalize, n°ʋu tuʊy choʉn Equalize selected  area only Ľʇʅʉc choʉn, l°ʉnh Equalize seω 

t²nh to§n v̈ §p dγng c§c bi̋n ĽΣi ri°ng cho vuʊng choʉn. N°ʋu tuʊy choʉn Equalize entire  
image based on selected area  Ľʇʅʉc choʉn, l°ʉnh seω Ľʇʅʉc tēʋnh toaʋn dʇʉa theo caʋc pixel 

trong vuʊng choʉn nhʇng sau Ľoʋ seω aʋp duʉng cho tön bΧ ʞnh. 
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25 . LąʉNH COLOR CAST 
 

1. Mʅʈ L°ʉnh Auto Color: ņ¹i khi aʈnh biʉ Color Cast (M©ʋt c©n bŁʊng maʊu), t³nh trʜng n̈y xʞy ra 
do queʋt aʈnh hoŁʉc do aʈnh g¹ʋc. ʝnh tromg file 03Start.psd  b̂ dʇ m̈ u xanh (Color Cast). Bʜn 
d½ng t²nh nŁng  Auto Color Ľʾ ch˄nh sλa. Bʜn v̈o: Menu Image | Auto Color (Ctrl+ Shift+ B), 

hi°ʉn tʇʅʉng dʇ maʊu xanh dʇʅng Ľaω Ľʇʅʉc loaʉi boʈ > ChΚn Menu File | Save Ľ°ʈ lʇu thay Ľ¹ʈi 
vʇʊa laʊm. 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 ʝnh Begin ʝnh After 
 

 
 
 

2. Giʞi th²ch:  L°ʉnh Auto Color Ľi°ʊu chēʈnh Ľ¹ʉ tʇʅng phaʈn vaʊ maʊu cuʈa aʈnh dʇʉa tr°n caʋc giaʋ triʉ t¹ʋi 
(Shadow), trung tēʋnh (Midtone) v̈ s§ng (Highlight) cεa biʾu ĽΠ phʜm vi t¹ng m̈ u (Color 

Channel) cεa file aʈnh. L°ʉnh naʊy seω Ľi°ʊu chēʈnh caʋc giaʋ triʉ trung tēʋnh vaʊ aʋnh xaʉ caʋc pixel t¹ʋi  
v̈ s§ng nhʠt trong aʈnh thaʊnh m ü Ľen v̈ m ü trʪng , dʇʉa tr°n caʋc giaʋ triʉ xaʋc l©ʉp trong 
h¹ʉp thoaʉi Color Correction Options. 

 
 

3. Color Channels  (Kênh Maʊu):  
 
¶ Ch°ʋ Ľ¹ʉ maʊu RGB: M¹ʉt aʈnh coʋ ch°ʋ Ľ¹ʉ maʊu RGB sy c· 3 K°nh maʊu lʇu trʇω th¹ng tin v°ʊ 3 

m̈ u tḧnh phʢn l̈ RED (ņoʈ) ï GREEN (Xanh laʋ) v̈ BLUE (Xanh dʇʅng). 
¶ Ch°ʋ Ľ¹ʉ maʊu CMYK:  M¹ʉt aʈnh coʋ ch°ʋ Ľ¹ʉ maʊu CMYK sy c· 4 K°nh maʊu lʇu trʇω th¹ng tin 

v°ʊ 3 m̈ u tḧnh phʢn l̈ CYAN (Xanh da trʅʊi), Magenta (ņoʈ caʋnh sen), YELLOW (M̈ u 
v̈ng) v̈ BLACK (M̈ u Ľen). 

¶ Çn c· th°m c§c k°nh m̈ u kh§c gΚi l̈ K°nh ALPHA  (Alpha Channnel) 
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4.  H¹ʉp Thoaʉi AUTO COLOR CORRECTION OPTIONS:  
 
¶ Cho pheʋp baʉn tʇʉ Ľ¹ʉng chēʈnh sʇʈa t¹ʈng quaʋt phaʉm vi t¹ng maʊu cuʈa aʈnh , g§n c§c gi§ tr̂ 

m ü cho Ľi°ʈm Ľi°ʊu khi°ʈn Shadow (T¹ʋi) , Midtone (Trung tēʋnh) v̈ Highlight (S§ng), x§c 

Ľiʉnh s¹ʋ %   pixel t¹ʋi hoŁʉc saʋng cuʈa aʈnh Ľʇʅʉc qui Ľ¹ʈi (Ćnh xʜ) sang giaʋ triʉ Shadow hoŁʉc 
Highlight. 
 

¶ Bʜn lʇu c§c x§c lʨp khi sʇʈ duʉng H¹ʉp thoaʉi Levels hoŁʉc Curves Ľ°ʈ sʇʈ duʉng laʉi sau naʊy 
trong caʋc l°ʉnh Levels , Curves , Auto Levels , Auto Contrast vaʊ  Auto Color. 

 
¶ Mʅʈ file aʈnh 03Star.psd > Ctrl+M Ľ°ʈ mʅʈ Curves > Nh©ʋp Options mʅʈ HT Auto Color 

Correction Options > Nh©ʉp giaʋ triʉ trong h¹ʉp nh©ʉp Clip vaʊ quan saʋt aʈnh trong luʋc thay Ľ¹ʈi 
gi§ tr̂ nhʨp, ʇng yʋ nh©ʋp OK. 
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26. LąʉNH REPLACE COLOR 
 

1. Tʜo MŁʉt Naʉ:  Vʅʋi L°ʉnh Replace Color, bʜn c· thʾ tʜo mΧt MŁʉt Naʉ (Mask) tʜm thΫi dοa tr°n c§c 
m̈ u Ľʇαc ch˄ Ľ̂nh v̈ sau Ľ· thay th̋ c§c m̈ u n̈y bʬng mΧt m̈ u kh§c . MŁʉt naʉ duʊng Ľ°ʈ c¹ l©ʉp 
m¹ʉt vuʊng trong aʈnh, cho pheʋp thay Ľ¹ʈi c§c hi˂u ηng cho v½ng Ľ« chΚn m̈  kh¹ng ʞnh hʇέng c§c 

v½ng çn lʜi trong ʞnh. H¹ʉp thoaʉi Replace Color coʋ caʋc tuʊy choʉn cho pheʋp chēʈnh sʇʈa caʋc thu¹ʉc 
t²nh m̈ u nhʇ HUE (M̈ u t²nh theo ĽΧ b§nh xe m̈ u ), SATURATION  (ņΧ bʞo ḩa, cʇΫng ĽΧ 

m̈ u), v̈ LIGHTNESS  (Lʇʅʉng maʊu trŁʋng vaʊ maʊu Ľen coʋ trong aʈnh). 
 

2. Download file aʈnh 03Start.jpg  tʜi (264 KB): http://goo.gl/lYhbB  > Menu file > ņ°ʋn file 

ʞnh vιa download > Ctrl+ 0 Ľʾ mέ ʞnh vιa kh²t m̈ n h³nh > ChΚn c¹ng cγ Rectangular > R° taʉo 
v½ng chΚn theo H³nh Minh HΚa  (N°ʋu thao taʋc sai, bʜn Ctrl+Z Ľ°ʈ huʈy thao taʋc vʇʊa laʊm hoŁʉc nh©ʋp 

Ctrl+D Ľ°ʈ huʈy vuʊng choʉn).  
 
3. Mʅʈ HT Replace Color:  Menu Image | Adjustments | Replace Color Ľ°ʈ mʅʈ HT Replace Color. 

Trong HT Replace Color tuʊy choʉn Selection Ľʇʅʉc choʉn mŁʉc Ľiʉnh, th°ʈ hi°ʉn mŁʉt naʉ cuʈa vuʊng choʉn. 
MŁʉt naʉ naʊy laʊ m¹ʉt lʅʋp (Thʇʉc ch©ʋt laʊ m¹ʉt aʈnh Grayscale ï ʞnh vΩi c§c cʠp ĽΧ x§m tι Ľen tΩi 

trŁʋng) phε l°n tr°n aʈnh. Ph©ʊn m ü Ľen sy che chŁʋn, giʇω cho caʋc hi°ʉu ʇʋng kh¹ng aʈnh hʇʅʈng 
tʅʋi aʈnh b°n dʇʅʋi. Ph©ʊn m ü trʪng sy kh¹ng che chŁʋn, cho pheʋp caʋc hi°ʉu ʇʋng t§c ĽΧng l°n 
ʞnh b°n dʇΩi. Pḧn m̈ u x§m ch˄ che chŁʋn m¹ʉt ph©ʊn, cho pheʋp caʋc hi°ʉu ʇʋng t§c ĽΧng l°n 

ʞnh b°n dʇΩi t½y thuΧc theo mʇʋc Ľ¹ʉ xaʋm taʉi vuʊng naʊy. 
 
4. T½y chΚn Selection v̈ Image:  Trong HT Replace Color, t½y chΚn Selection khi Ľʇʅʉc choʉn seω 

th°ʈ hi°ʉn mŁʉt naʉ cuʈa vuʊng choʉn trong Ď xem trʇʅʋc coʊn t½y chΚn Image khi Ľʇʅʉc choʉn seω th°ʈ 
hi°ʉn aʈnh cuʈa vuʊng choʉn trong ¹ xem trʇʅʋc. C· thʾ chuyʾn ĽΣi qua lʜi Selection v̈ Iamge trong 

qu§ tr³nh tʜo m̡ t nʜ.   
 
5. Hʇʅʋng d©ωn sʇʈ duʉng:  Trong HT coʋ 3 c¹ng cuʉ hēʊnh ¹ʋng huʋt.  

¶ C¹ng cuʉ Eyedropper  d½ng Ľʾ nhʠp nhi̓u lʢn l°n v½ng cʢn thay th̋ m̈ u , Ľʾ c§c m̈ u 
trong vuʊng choʉn seω trʅʈ thaʊnh maʊu trŁʋng nhʇng v©ωn coʊn soʋt kh¹ng thu©ʊn trŁʋng. 

¶ C¹ng cuʉ Add To Sample  r° l°n khŁʋp vuʊng maʊu trŁʋng Ľ°ʈ th°m trŁʋng hoaʊn toaʊn. 
¶ C¹ng cuʉ Subtract From Sample  nh©ʋp l°n nhʇωng ch¹ʈ ngoaʊi vuʊng c©ʊn thay th°ʋ maʊu 

(Nhʇng trong vuʊng choʉn) Ľʾ loʜi bΜ c§c v̋t trʪng nhΜ çn s·t. 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 

http://goo.gl/lYhbB
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6. ChΚn c¹ng cγ Eyedropper (Νng giΚt tr§i), nh©ʋp v̈o nhνng Ľiʾm tʇΫng m̈ u xanh  dʇʅng 
trong cʇʈa s¹ʈ aʈnh seω hi°ʉn ra maʊu trŁʋng tr°n mŁʉt naʉ trong HT Replace Color. 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
7. ChΚn c¹ng cγ Add To Sample  (Νng giΚt giνa), rê  v̈o v½ng tʇΫng m̈ u xanh dʇʅng trong cλa 
s¹ʈ aʈnh cho Ľ°ʋn khi toaʊn b¹ʉ ph©ʊn tʇʅʊng trʅʈ thaʊnh toaʊn maʊu trŁʋng tr°n mŁʉt naʉ. 
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8. Nh©ʉp giaʋ triʉ Fuzziness laʊ 80  hoŁʉc r° con trʇʅʉt seω caʊng taʉo  ra vuʊng maʊu trŁʋng Ľʇʅʉc th°m vaʊo. 
9. Bʜn chú ý:  Trong vòm cʇʈa s¹ʈ ngoaʊi ph©ʊn tʇʅʊng (Trong mŁʉt naʉ) c· s·t v̈i v˂t m̈ u trʪng, bʜn 

chΚn c¹ng cγ Subtract From Sample  (Νng giΚt Phʞi) nh©ʋp l°n vaʉch trŁʋng naʊy Ľ°ʈ loaʉi boʈ v°ʉt 
trŁʋng thʇʊa. 

 

 
 
  

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
10. ChΚn m̈ u thay th̋: Nh©ʋp Ď maʊu Result, hi°ʉn ra h¹ʉp maʊu vaʊ choʉn maʊu Ľoʈ > Nh©ʋp Ok. 

 
 

 
  
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

11. Ď Result Ľaω hi°ʉn ra maʊu baʉn vʇʊa choʉn vaʊ Ľ¹ʊng thʅʊi maʊu vaʋch tʇʅʊng cuωng Ľaω thay Ľ¹ʈi. 
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12. HoŁʉc nh©ʉp giaʋ triʉ vaʊo Ď Hue (50) v̈ Saturation (50), giʇω nguy°n Lightness laʊ 0, bʜn cƶng seω 

c· mΧt m̈ u kh§c thay th̋ > Nh©ʋp Ok > Ctrl+D Ľ°ʈ boʈ vuʊng choʉn > ChΚn File | Save Ľ°ʈ lʇu laʉi 
hoŁʉc nh©ʋp nuʋt Save. 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

13. Trʅʈ laʉi giaʋ triʉ ban Ľ©ʊu cuʈa HT Replace Color: Bʜn nhʠn giν Ph²m Alt Ľʾ chuyʾn n¼t Cancel 
tḧnh N¼t RESET v̈ nhʠp v̈o n¼t n̈y. 

 



27 

 

14. Sʇʈ duʉng nuʋt Save vaʊ nuʋt Load:  Bʜn nhʠp n¼t Save Ľʾ lʇu c§c x§c lʨp (Fuziness,transform) 
v̈o file theo Ľ̂nh dʜng .AXT . ņ°ʈ sʇʈ duʉng laʉi caʋc xaʋc l©ʉp Ľaω lʇu , nh©ʋp nuʋt Load vaʊ choʉn m¹ʉt 

file.AXT Ľaω lʇu trʇʅʋc Ľ©y. 
 

15.  CĆC PHĉM TʩT: 

 
 D½ng cho c¹ng cγ: Eyedropper ï Add To Sample  vaʊ Subtract From Sample. 
 

CĎNG CUʉ ņANG CHOʉN PHĉM Ḱ T HΰP CĎNG CUʉ CHOʉN TAʉM THʄʊI 

EYEDROPPER 
SHIFT ADD TO SAMPLE 

ALT SUBTRACT FROM SAMPLE 

ADD TO SAMPLE 
CTRL EYEDROPPER 

ALT SUBTRACT FROM SAMPLE 

SUBTRACT FROM SAMPLE 
CTRL EYEDROPPER 

SHIFT ADD TO SAMPLE 

 
 
16.THʆʉC TĄʉP: 

 
¶ Menu File > ņ°ʋn File aʈnh (49KB) : http://goo.gl/bN4WT  > Nh©ʋp Open > ņaʈ hi°ʉn ra aʈnh 

trong Cʇʈa S¹ʈ Laʊm Vi°ʉc. 
¶ ChΚn c¹ng cγ Polygonal Lasso Tool> ChΚn T½y chΚn Feather l̈ 2 px Ľ°ʈ laʊm m°ʊm vuʊng bi°n > 

Ch©ʋm r° tʇʊng Ľoaʉn nhoʈ tr°n noʋ maʊu xanh Ľ°ʈ taʉo vuʊng choʉn > Khi n¹ʋi 2 Ľ©ʊu Ľʇʅʊng r° vʇʊa 
tʜo n· tʜo ra v½ng chΚn c§i n·n maʊu xanh. 

¶ V̈o Menu Imge > Adjustmants > Replace Color > Hi°ʉn ra HT cuʈa l°ʉnh naʊy, trʞ v̓ m̡ c Ľ̂nh 
ban Ľ©ʊu vēʊ trʇʅʋc Ľoʋ baʉn Ľaω duʊng HT naʊy bŁʊng caʋch giʇω Phēʋm Alt vaʊ nh©ʋp nuʋt Reset. 

¶ Ćp dγng hʇΩng dʦn tr°n bʬng c§ch sλ dγng 3 Νng giΚt nʇΩc > Nh©ʉp Hue 90 v̈ Saturation 
20, giʇω nguy°n Lightness laʊ 0 > Nh©ʋp Ok.  

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 

http://goo.gl/bN4WT
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¶ Bʜn Ľ« thay th̋ m̈ u n·n tι xanh l§ c©y tḧnh t²m > Nh©ʋp Ctrl+D Ľ°ʈ xoʋa vuʊng choʉn. 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
¶ S·t m ü:  C§c bʜn ch¼ Ĩ: Do trong luʋc taʉo vuʊng choʉn baʉn kh¹ng phoʋng to aʈnh khi Ľ°ʋn vuʊng 

mŁʋt do Ľoʋ baʉn kh¹ng taʉo Ľʇʅʉc chēʋnh xaʋc cho nʅi Ľ©y. H©ʉu quaʈ laʊ thay th°ʋ maʊu kh¹ng coʊn soʋt 
lʜi m̈ u gΞc. 
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27 .THδ THUʧT PHOTOSHOP CS5 
 

1. Bi°ʋn nuʋt CANCEL thaʊnh nuʋt RESET:  Bʜn mέ mΧt ʞnh Ľʾ ch n˄h sλa và nhʠp Ctrl+L (Ví dγ) Ľʾ 
mέ mΧt HΧp Thoʜi  (levels), sau Ľó bʜn nhʨp các giá tr  ̂ vào. Bʜn thʠy sο thay ĽΣi không nhʇ 
mong muΞn, bʜn có th  ʾ trέ lʜi lúc ban Ľʢu mΩi mέ HT bʬng cách giν Phím Alt Ľ ʾ bi n̋ nút 

CANCEL thành nút RESET, sau Ľó bʜn nhʠp nút RESET Ľ ʾtrέ lʜi trʜng thái ban Ľʢu mΩi mέ HT. 

 
 

2. ChΚn nhanh Layer: Mέ file ʞnh > Ph²m F7 Ľ ʾmέ Layer Background > Phím Ctrl+J Ľ ʾmέ Layer 
1 > ChΚn công cγ Move > Nhʠp Phʞi lên ʞnh > Hi n˂ ra Context Menu > ChΚn mΧt LΩp Layer. 
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3. CuΧn t ι bàn phím : Bʜn có th  ʾcuΧn Ľʾ xem ʞnh bʬng cách nhʠn các phím sau: 
¶ Home        : CuΧn Ľ̋n góc cao bên trái. 

¶ End           : CuΧn Ľ̋n góc dʇΩi bên phʞi. 
¶ Page Up     : CuΧn lên trên cùng (Giν Shift Ľ ʾcuΧn tι tι). 

¶ Page Down : CuΧn xuΞng dʇΩi cùng (Giν Shift Ľ ʾcuΧn tι tι). 

 
4. Zoom ʞnh b ʬng bàn phím:  

¶ Ctrl+ : ņʾ phóng to ʞnh. 
¶ Ctrl -: ņʾ thu nhΜ ʞnh. 

¶ Ctrl+Alt và D ʠu + hay d ʠu - :  ņʾ  phóng to ho c̡ thu nhΜ cʞ ʞnh và cλa sΣ ʞnh. 
¶ Ctrl+ phím 0 : ņʾ xem ʞnh t  ˄l  ˂100%. 

 

5. Gia sΞ bʬng Phím:  ņʾ  tŁng giàm giá tr  ̂trong ô thông sΞ cεa hΧp thoʜi bʜn bʜn nhʠp phím mεi 
tên. MΥi lʢn nhʠp s  ylàm thay ĽΣi mΧt Ľʅn v  ̂v  ̂giá tr  ̂nhʇng n ű giν Phím Shift  thì làm thay ĽΣi 
10 Ľʅn v.̂ 

 
6. Thu g Κn các Palette : Giν Alt và nhʠp vào nút Collapse ho̡ c nhʠp Ľúp vào Tab cεa Palette Ľ ʾ

thu nhΜ nhʠt Palette Ľó. 

 
7. ņ̂nh v  ̂cho Palette:  Giν Shift và nhʠp lên Title Bar cεa Palette Ľ ʾĽʇa Palette Ľó ra rìa màn 

hình gʢn nhʠt. Giν Shift trong khi di chuy nʾ Palette sy  làm Palette di chuy nʾ dΚc theo biên cεa 
màn hình. 

 

8. Di chuy nʾ ņʇΫng PATH:  Dùng công cγ Direct Selection  nhʠp vào ĽʇΫng Path trong khi giν 
phím Alt s  ygiúp chΚn cʞ ĽʇΫng Path Ľó, sau Ľó thʞ Alt và kéo rê Ľʾ  di chuy nʾ nó. 

 
9. Tô màu b ʬng phím Delete:  

 

¶ Altl+Phím Delete   :  ņʾ  tô màu Foreground cho vùng chΚn.  
¶ Ctrl+Phím Delete   : ņʾ tô màu Background cho vùng chΚn. 

¶ Ctrl+Shift+Delete : ņʾ tô màu Background cho nhνng mi n̓ không trong suΞt. 

 
10.Tô màu b ʬng Phím Back Space : 

¶ Ctrl+Back Space : ņʾ tô màu Background. 

¶ Alt+Back Space   : ņʾ tô màu Foreground. 

 
11.Tʞi vùng ch Κn trong su Ξt cεa mΧt l Ωp: Giν Phím Ctrl rΠi nhʠp lên tên lΩp trong Layer Palette 

Ľʾ  tʞi vùng chΚn trong suΞt cεa lΩp Ľó. MuΞn tʞi thêm nhi u̓ vùng chΚn khác thì giν thêm phím 
Shift. 

 

12.Nhʠp giá tr  ̂Opacity cho các công c γ tô v  ybʬng phím  sΞ: Nhʠp phím sΞ 1 Ľʾ nhpʨ giá tr  ̂
Opacity bʬng 10%, sΞ 2 cho 20%, . . .s Ξ 9 cho 90% và sΞ 0 cho 100%. Nhʠn 2 sΞ liên tγc tηc là 
nhʨp  cho Opacity mΧt giá tr  ̂chính xác. 

 
LÂM NGΙC QUÂN 

 
 

 

28.CÔNG Cβ DODGE VÀ BURN 
 
× CÔNG Cβ DODGE 
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Công cγ Dodge dùng Ľʾ làm s§ng hʅn cho vùng sáng  và làm tŁng ĽΧ chi ti t̋ cεa vùng Ľó. ThʇΫng 
dùng làm trʪng rŁng, trʪng tròng mʪt, trʪng nhνng nʅi Ľã trʪng mà bʜn muΞn làm trʪng hʅn nhʇng 

không muΞn thʠy trʪng giʞ tʜo. 
 

1. Mέ file ʞnh 03Start.psd > Nhʠp chΚn công cγ Dodge (o)  trong hΧp công cγ. 

2. Trên Thanh tùy chΚn, chΚn các xác lʨp nhʇ sau: 
¶ Nhʠp hΧp chΚn Brush Ľ ʾmέ bΧ chΚn nét bút Ľ̂nh s nh, chΚn mΧt nét bút khá lΩn có biên 

mΫ, nhʇ Soft Round 27 pixel. Nhʠp bên ngoài Ľʾ  Ľóng bΧ chΚn lʜi. 
 
 

 
  

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
¶ Nhʠp chΚn  hΧp danh sách Range, chΚn phʜm vi tông màu ch û tác ĽΧng là Highlight 

(Vùng sáng) Ľʾ làm sáng hʅn. 
¶ ά tùy chΚn Exposure , chΚn cʇΫng ĽΧ tŁng sáng là 15% bʬng cách nhʨp trοc ti p̋ vào Ô 

nhʨp (ho c̡ dùng thanh trʇαt). Giá tr  ̂cʇΫng ĽΧ Exposure tι 0-100%. 
 

 
  
 

 
 

 
 
 

3. Rê con trΜ theo hʇΩng Ľηng tι trên xuΞng dʇΩi trên phʢn rèm cλa sΣ Ľʾ các chi ti t̋ rèm cλa 
sΣ trông rõ hʅn. Không nhʠt thi t̋ phʞi rê theo hʇΩng Ľηng, nhʇng Ľi̓u này mang k t̋ quʞ tΞt 

hʅn. Bʜn mέ file 03End.psd Ľ ʾk  ̋bên Ľʾ tham khʞo. N ű không hài lòng vΩi k t̋ quʞ vιa rê, 
bʜn  nhʠp Ctrl+Z Ľ ʾhεy thao tác vιa làm. K t̋ quʞ là các chi ti t̋ trên rèm cλa sΣ trông rõ và 
sáng hʅn. Bʜn cò th  ʾrê nhi u̓ lʢn lên trên rèm. Xong nhʠp File | Save. 

4. N ű muΞn sλ dγng công cγ Dodge vΩi tính nŁng cεa công cγ AirBrush : Nhʠp công cγ 
AirBrush trên thanh tùy chΚn > Nhʠn giν chuΧt tʜi mΧt Ľiʾm trên ʞnh tác dγng tʜi v  ̂ trí này 

s  ycàng mʜnh. 
5. Cách rê nhanh : Nhʠp v  ̂trí Ľ˄nh > Giν Shift > Nhʠp con trΜ v  ̂trí Ľáy cεa ĽʇΫng thʮng. Bʜn 
Ľã tʜo hi u˂ ηng Dodge theo ĽʇΫng thʮng. 
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6. Các bʜn có th  ʾ áp dγng các tùy chΚn trên cho ʞnh thοc tʨp (http://goo.gl/nfFkP ) dʇΩi 
Ľây: 

 
 

 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 

http://goo.gl/nfFkP
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× CÔNG Cβ BURN 
 

1. Ngʇαc vΩi công cγ Dodge, thay vì làm sáng hʅn phʜm vi tông màu Ľʇαc chΚn (Shadow, Midtone 
và Highlight), công cγ Burn s  y làm chúng Ľʨm và tΞi hʅn. Bʜn có th  ʾ áp dγng cho Lông mày, 
trong Ľen mʪt, nhνng khía cʜnh cʢn cho sʨm hʅn. Các chΚn tùy chΚn và các thao tác cƶng giΞng 

nhʇ công cγ Dodge. 
2. Công cγ Dodge và Burn là 2 công cγ trái ngʇαc nhau. Tuy nhiên n ű Ľã sλ dγng mà có k t̋ quʞ 

không tΞt bʜn không nên ti p̋ tγc dùng công cγ này Ľʾ sλa chνa lʜi. Bʜn nên dùng l n˂h Menu 
Edit| Undo ho c̡ Ctrl+Z Ľ ʾhεy bΜ mΧt thao tác  ho c̡ dùng Bʞng History Ľ ʾhεy bΜ nhi u̓ thao tác 
rΠi dùng lʜi 2 công cγ này. 

 

 
 

 
 
  

29 . ʝNH TΝI Vê THÍU SĆNG. 
 

B̈i vi̋t n̈y gαi Ĩ tι hʇΩng dʦn cεa KS Dʇʅng Trung Hi̋u ñ King of Photoshopò .Bʜn c· nhνng bηc 
ʞnh chγp trong nḧ thʇΫng b̂ tΞi v³ thi̋u s§ng, Ľeʊn Flash gŁʋn li°ʊn trong maʋy chuʉp aʈnh KTS kh¹ng Ľuʈ 
cʇʅʊng Ľ¹ʉ phaʊ Ľ°ʋn nh©n v©ʉt. Nhʇωng aʈnh naʊy r©ʋt d°ω chēʈnh sʇʈa sau khi baʉn aʋp duʉng baʊi hʇʅʋng d©ωn 

dʇʅʋi Ľ©y seω cho baʉn m¹ʉt bʇʋc aʈnh hoaʊn haʈo Ľ©ʊy Ľuʈ aʋnh saʋng vaʊ maʊu sŁʋc cuωng nhʇ Ľ¹ʉ tʇʅng phaʈn 
Ľaʉt y°u c©ʊu cuʈa m¹ʉt aʈnh  Ľeʉp. Ri°ng aʈnh ch©n dung chuʉp trong nhaʊ nh©ʉn Flash Ľ°ʋn khu¹n mŁʉt  

cʇʅʊng Ľ¹ʉ phaʊ saʋng kh¹ng bao truʊm h°ʋt khu¹n mŁʉt do Ľoʋ hai b°n h¹ng goʊ maʋ biʉ nhu¹ʋm t¹ʋi , nhʇωng 
ʞnh n̈y rʠt kh· ch˄nh sλa cho ĽΠng bΧ vΩi ĽΧ tʇʅng phʞn cεa cʞ khu¹n mŁʉt. Đt B˄nh sy c· b̈i vi̋t 
sau v°ʊ v©ʋn Ľ°ʊ naʊy.  

 
1.  Download aʈnh thʇʉc t©ʉp (277 KB): http://goo.gl/8wxBX  . Lʇu aʈnh taʉi Desktop. ņ©y laʊ Giaʋo Sʇ 
B§c Sƙ Da Liˀu NGUYʿN VŀN ĐT , nay 96 tu¹ʈi, l̈ ngʇΫi Ľ« cηu sΞng Đt B˄nh c§ch nay tr°n 20 

nŁm sau khi caʋc BS B°ʉnh Vi°ʉn Da Li°ωu baʈo v°ʊ nhaʊ mu¹ʋn ñŀn gēʊ cʇʋ Łnò . Mʅʊi Ľoʉc baʊi vi°ʋt hʇʅʋng 
d©ωn giʇω gēʊn sʇʋc khoʈe cuʈa BS Uʋt: http://goo.gl/5Ox9u . Đt B˄nh vi°ʋt baʊi naʊy Ľ°ʈ in aʈnh tŁʉng 

Th©ʊy Uʋt kēʋnh y°u cuʈa Uʋt Bēʈnh. 
 

2. Mʅʈ aʈnh: Menu File > ņ°ʋn nʅi lʇu aʈnh > Nh©ʋp Open > ʝnh hi˂n ra trong V½ng L̈m Vi˂c.C§c bʜn 

ch¼ Ĩ ņʇΫng biʾu diˀn Histogram cεa ʞnh n̈y kh¹ng Ľʜt h̋t tι 0 Ľ̋n 255 Ľʾ so s§nh vΩi ʞnh 
END.. 

http://goo.gl/8wxBX
http://goo.gl/5Ox9u
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3. Sʇʈ duʉng HTShadows/Highlight : Nh©ʋp Phēʋm F7 Ľʾ mέ Tab Layers > Nh©ʋp Menu Image | 

Adjustments | Shadows/Highlight hi°ʉn ra H¹ʉp thoaʉi Shadows /Highlight > Bʜn nhʠp v̈o n¼t 
Shows More Options Ľʾ mέ rΧng HT c· nhi̓u t½y chΚn > Bʜn nhʨp Radius l̈ 300 v̈ Color 

Correction laʊ + 60 > Nh©ʋp Ok. ʝnh Ľ« s§ng hʅn. 
 
 

 
 

  
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 


